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The Power of Intention 
 

Intention determines your life. 
It’s a mistake to just think about what you want to do without thinking about intention. Failing to Plan is 
Planning to Fail. Have a plan, work your plan! 

Luck: When Preparation meets Opportunity 
We want to be prepared to handle that moment of opportunity 

Reaching potential members (VIPs) with WOW = HIGH IMPACT 

Actionable Ideas: 
• Get Out 

o Tabling (At a mall, at a parade, at a sports event, at a school, car boot/trunk) 
o Develop a club membership display in a “go box” (Glory Box in Australia) 
o Tabling Tips https://youtu.be/s6hzOKVjknI (15 min view later) 
o Prepare Yellow Folder Materials/Guest gifts 
o “Selfie Frame” - Add hashtag (template?) Pictures on slide 

• Invite In 
o Hold Special Events & make them special 

 Young Talents Workshops (like End Campus Violence) 
 University Student Gatherings (feed them & they will come) 
 8 March, International Woman’s Day event 
 Partner with existing organizations 
 When do you hold a membership open house? 

• Show up 
o Ensure every public event has a commercial - make a good one! 
o Advertise events/scholarships (Church bulletins, Student Clubs) 
o USE A BIG CHECK (“Cheque”) Show me the money! 
o Use Social Media/Hashtags (See handout) 
o Mind Branding, be sure documents/images convey mission & inclusiveness 

• Leave Prepared 
o Pin Proud 
o What’s in Your Wallet 
o Know the Date of next meeting or event 
o Practice the 3 questions: 
o Do you ever wish? 
o Have you ever?  
o Do you ever find yourself?  



 
 

Add Some WOW to Online Ceremonies 
 
 
So on Zoom, before your meeting begins, go to this website: https://www.boldts.net/light-a-candle/. 
(Blow out the candles if any are lit.) 

When it’s time for the candles, click the green button to share your screen (select the window with 
candles) and share button again to start.   

When you see Zoom's green box around your window, you'll know you are sharing.  

Have a great ceremony! 
  

https://www.boldts.net/light-a-candle/


Zonta Hashtags 
 
What is a hashtag? And why do you need to use them? This integral part of social media is essentially 
a sorting label. It helps others interested in a certain topic, to quickly find content on that same topic. 
They can be used to raise awareness for a cause or to start a conversation. They can help to increase 
followers and to increase engagement with the followers. Hashtags boosts your brand!   

Simple rules: 
• No spaces allowed. 
• No punctuation or symbols other than # that they start with. Usually, you add it to the end of 

messages.  
• Keep it to 3-5 tags per message.  (Less for Twitter)  
• Upper- or lower-case letters are fine. Search your hashtag to see what content is out there 

already. They should be easy to remember and understand.  
• Create one for each of your big events. 
• Be sure your posts are set to public or no one will see your hashtags!  

 
Place on all Zonta posts. Use tags related to the content and add unique identification, like the district 
(#ZontaD9) or the particular Zonta Club (#SantaClaritaValley) Remember to include event location. 
(#Hamburg #Germany)  
 
If you have a Z Club/or Golden Z, always add them. #GVHighSchool #CanyonZClub 

Even writing articles that posted to blogs, its ok to add hashtags within your articles. Google looks for 
that and will bring people to your website. You can always edit a post to have better reach.  
 
Here are some we use:  
#zonta #zontainternational #zontaintl #zontians #womensupportingwomen #womenempoweringwomen 
#ZontaEmpowers #TakeActionNow #HonorAndEmpower #womensempowerment #ZontiansInAction 
#genderequality #genderequalitynow #genderequalitymatters #zontasaysyestogenderequality 
#zontaclub #ZontaSaysNOW! #Inspire #Empower #AchieveYourDreams #Beproud #ZontaProud 
 
 
#ZontaSaysNO 
#ZontaSaysNO #zontasaysnotoviolenceagainstwomen #zontasaysnotoviolence 
#envisioningaworldwithoutviolence 
 
16 Days of Activism 
#16DaysofActivism #16days #envisioningaworldwithoutviolence #ZontaSaysNO 
#zontasaysnotoviolence #endhumanslavery #zontasaysnotoviolenceagainstwomen 
#endhumantrafficking #endhumanslavery #womensrightsarehumanrights #orangetheworld 
#EndViolenceAgainstWomen #REDressProject #genderequality #countmein #18NoExceptions 
#endchildmarriage #FGM #endfgm 
 
#Envisioning #allyship #community #orange #service #studentengagement #knowldege #outreach 
#tribute #reflection #GivingTuesday #Listening #discussion #awareness #advocacy #reflection 
 
FGM  
#FGM #femalegenitalmutilation #femalegenitalmutilationawareness #endfgm 
#zontasaysnotoviolenceagainstwomen #ZontaSaysNo #zontasaysnotoviolence 
#envisioningaworldwithoutviolence  #WomensHealth, #LetsEndFemicide! 
 
 

https://www.facebook.com/hashtag/womenshealth?__eep__=6&__tn__=*NK*F
https://www.facebook.com/hashtag/letsendfemicide?__eep__=6&__tn__=*NK*F


HUMAN TRAFFICKING 
#EndHumanTrafficking #not4sale #humantraffickingawareness #ZontaSaysNO 
#zontasaysnotoviolence #endhumanslavery #zontasaysnotoviolenceagainstwomen 
#envisioningaworldwithoutviolence 
 
ENDCHILDMARRIAGE 
#EndChildMarriage #EndForcedMarriage #18NoExceptions 
#ChainInCelebration #EndChildMarriageUSA #6down44togo #ZontaSaysNO #zontasaysnotoviolence 
#endhumanslavery #zontasaysnotoviolenceagainstwomen #envisioningaworldwithoutviolence 
 
DONATION 
#ThankfulTuesday #donation #charity #nonprofit #community #donationwelcome #donationsneeded 
#donationdrive #donatetoday #nonprofitsofinstagram #communityoutreach 
 
VOLUNTEERING 
#joinzonta #joinzontatoday #volunteer #leadership #charity #nonprofit #community #JoinUs #service 
#volunteers #volunteering #nonprofitsofinstagram #communityoutreach 
 
Z Club 
#Zclub #zclub #GoldenZClub #empowering #passionate #honest #friends #collaboration #caring 
#committed #leaders #support #advocacy #international #mentoring #giving #confident #dedicated 
#justice #courage #strong #service #action #education 
 
YWPA Scholarship 
#EmpowerYourself #scholarshipprogram #scholarship #StrongLeadershipStrongWomenStrongWorld 
#charity #nonprofit #community #YWPA #youngwomen #YoungWomenEmpowerment 
#youngwomenleaders #youngwomenscholarship #womenscholars #publicaffairs  
#educationisahumanright  
 
GENDER EQUALITY 
#ZontaSaysYEStoGenderEquality #genderequality #genderequalitynow #genderequalitymatters  
#HeForShe 
 
MISCELLANEOUS 
#IWD #ZontaRoseDay 
#StopAsianHate 
#love 
#PhotoOfTheDay 
#happy 
#WomensHealth 
 #LetsEndFemicide 
 
On LinkedIn 
#PersonalDevelopement 
  

https://www.facebook.com/hashtag/womenshealth?__eep__=6&__tn__=*NK*F
https://www.facebook.com/hashtag/letsendfemicide?__eep__=6&__tn__=*NK*F


 
Want to Know More About Zonta International? 

 
MISSION  
Zonta International is a leading global organization of professionals empowering women worldwide 
through service and advocacy. 
 
VISION 
Zonta International envisions a world in which women's rights are recognized as human rights and 
every woman is able to achieve her full potential.  In such a world, women have access to all resources 
and are represented in decision-making positions on an equal basis with men.  In such a world, no 
woman lives in fear of violence. 
 
MORE 
Zonta was established in 1919, has 1300 clubs in 63 countries. Zonta International holds General 
Consultative Status with the United Nations Economic and Social Council and Participatory Status with 
the Council of Europe.  At the local level, Zonta clubs partner with local NGOs that share our vision. 
Zonta International partners include UNFPA, UNICEF USA, UN Women, Girls Not Brides, Coalition to 
End Violence Against Women and Girls Globally and Women's Empowerment Principles.  
Zonta International and the Zonta Foundation for Women are financially efficient, fully transparent and 
accountable to both our members and donors. Zonta has been working to create a more equitable 
future for women and girls. We believe that fostering a diverse and inclusive global community is a 
powerful platform to bring about the social change needed to make our vision for gender equality a 
reality. As a global organization, Zonta International values the contributions of members of all 
backgrounds, regardless of age, ethnicity, race, color, ability, religion, socio-economic status, culture, 
sexual orientation or gender identity. We believe that a diverse community of members is essential to 
our ability to achieve our mission to create a more equitable future.  
 
There are three ways to join a Zonta Club: 

1. Submit a membership application to Zonta International, which will be routed to your nearest 
club by Zip-code  (www.zonta.org) 

2. Contact a Zonta club near you and request an invitation to join. 
3. Start a Club by you (Min 15 people)  

 
The rewards of Zonta International membership: 

• Join a global group of like-minded people, helping women and girls 
• Contribute to your local community in a rewarding and enjoyable way 
• Create friendships locally, nationally and internationally 
• Develop personal and leadership skills 
• Make a difference to the world around you  
• Learn more about gender issues and the advocacy process 
• Experience a joyful purpose 
• Have a large beneficial impact in a small amount of time  

The expectations of Zonta International membership:   

http://www.zonta.org/


Members join Zonta International via a club in a defined district and pay annual dues averaging about 
50 cents a day. Members are expected to attend club meetings (10-12 times a year) and to consider 
accepting occasional invitations to district / International events.  It is helpful to read newsletters of club, 
district, International to stay current. There is a Zonta App for Apple or Android that is free to members 
and makes connecting very easy. Clubs participate in a local hands-on service project decided by the 
members once a year, honor women in their community on International Woman’s Day and create 
fundraising opportunities for support of International Educational and Service Projects. Members are 
expected to be kind, honest, helpful and loyal. Members have leadership opportunities available to 
them.  
Zonta Clubs are non-sectarian and non-partisan.   

 

My Name:   ________________________________   
My Club:_________________ 

For more information Membership@ZontaDistrict2.org  

  

mailto:Membership@ZontaDistrict2.org


Tabling (meeting the public): Plan to do This on a Regular Basis 
 
See this video: Tabling Tips https://youtu.be/s6hzOKVjknI (15 minutes long)  
 
Tabling is a great way to increase visibility for ZONTA, to spread the word about ZONTA’s work, and to 
attract new members. 
 
But there’s more to it than sitting at a table with brochures.  
 
Here’s a guide to learn how to plan a tabling event that recruits new members and engages 
your community.  
 
Set up a table with information and sign-up forms and then engage with passersby. Engaging from a 
table is a lot like the beginning of a courtship process. You’ve got to catch the eye! (Stop a moving 
target!)  
 
BEFORE THE EVENT 
1.  Choose a location. Set up your table in a high-traffic area with good visibility. (If people can’t see 
your table from far away, they will be less likely to stop by.) Where? Some places included: Farmers’ 
market; Shopping Center; community center; college; or university. When tabling on a college or 
university campus, choose to be outside the student center or in front of the dining hall. 
 
2. Be recognizable from across the room. (Colors, Branding, Signage)  
 
3. Choose a focus. Zonta does a lot of good work, but it can be overwhelming if it’s all displayed on one 
table. Instead, choose a specific issue or program to focus on (such as equal pay or women in science, 
technology, engineering, and mathematics) during your tabling event. Choose an issue that will be 
relevant to the specific audience. For example, if you are tabling on a college campus in the fall before 
an election, you may want to have Zonta get-out-the-vote information available. 
 
4. Plan an “ask” or two. Tabling should do more than just inform people about an issue. You also want 
them to take action! Once you select an issue or program to focus on, choose a specific way you’ll ask 
them to get involved. Ask them to attend an upcoming event, join our Action Network, or sign your most 
recent petition. If your tabling location has Internet access and electrical outlets available, you may be 
able to set up a laptop for people to take action immediately at the table. If you’re tabling on a college 
campus that is a college/university partner, make sure you’re signing students up to become 
free student affiliates. Look for a Golden Z Club leader! 
 
5. Recruit and train volunteers. Tabling is an easy way for new and seasoned members alike to 
contribute to the club’s work. Encourage all your members to be a part of your tabling activities, and 
build their skills and confidence by providing training ahead of time. Fill them in on your focus, asks, 
and the tabling best practices shared in this resource. Then have them role-play engaging passersby 
and give them feedback. Let volunteers sign up for a shift.   
 
6. Advertise your presence at an event. Put up flyers, post on social media, and send e-mails 
announcing when and where you will be tabling. The more people know about your table in advance, 
the more people will stop by. 
 
7. Gather materials. Print copies of your applications. You can order a 3-by-5-foot banner, sign, or 
tablecloth from Zonta store you don’t already have one. Make sure you have the advocacy materials 
and membership and program brochures and postcards you need. 
 

https://youtu.be/s6hzOKVjknI
https://www.aauw.org/what-we-do/
https://www.aauw.org/fairpay/
https://www.aauw.org/what-we-do/stem-education/
https://www.aauw.org/what-we-do/stem-education/
https://www.aauwaction.org/my-vote/
https://www.aauw.org/what-we-do/public-policy/two-minute-activist/
https://www.aauw.org/resource/how-to-start-a-petition/
https://www.aauw.org/what-we-do/public-policy/two-minute-activist/
https://www.aauw.org/membership/college-university-partner/
https://svc.aauw.org/RECore/wMembership/join_esaf_member.asp
https://www.aauw.org/article/become-a-student-affiliate/
https://www.aauw.org/resource/leader-essentials-marketing-and-visibility/
https://www.aauw.org/resource/how-to-use-social-media-for-advocacy/
https://www.aauw.org/resource/upcoming-advocacy-activity-events-form/
http://aauw.source4.com/b2c/Category.asp?Category=1583


8. Consider tabling with a video.  Video is a fantastic tool to help you engage with future members and 
show the world what Zonta does on behalf of women and girls. Use a laptop or I-pad to play the video 
continuously when you table; it will attract attention and add a visual element to your ask. To avoid 
having to rely on Wi-Fi or Internet access, download the file. Before the event, find the closest power 
outlet, figure out whether you will need an extension cord, and practice running the video. 
 
DURING THE EVENT 
Tips on stopping that moving target: (Approaching passersby) Have at least one member standing in 
front of the table who approaches people as they walk by instead of waiting for people to come to them. 
It helps to develop a good “stopper” line — something you can say to grab their attention and draw 
them toward the table. For example, lines such as “Do you value equality?” or “Do you know about 
ZONTA?” or “Did you know this group is trying to end child marriage?” may intrigue passersby enough 
that they stop to learn more about your work. (A brief way to explain Zonta is, “ Zonta is a global 
organization that builds a better world for women and girls.)   
 
Invite them to fill an entry for a free drawing  (name, email address, and a few questions) You want to 
get their contact information so that you can keep them informed about your group’s work.     
 
Have a giveaway. People are enticed by freebies and are more likely to stop by your table if they get 
something for doing so. Some examples of Zonta merch - branded giveaways such as pens, 
highlighters, reusable, logo’d shopping bags or even mints (sticker them with a note Thanks a mint for 
learning more about Zonta www.Zonta.org!) 
 
Make your ask: Invite them to get involved! (See #4 in BEFORE THE EVENT) 
 
AFTER THE EVENT 
Follow up. Get in touch with the people who took action at your table. E-mail will work, although a 
phone call can be more personal. The follow-up conversation is an opportunity to confirm their 
attendance at your upcoming event or make another ask, such as coming to a future club meeting.  
 
This 4-Question method works well for drawing slips. Put on clipboards and write the answers for the 
guest. Everyone who answers these 4 questions goes into the drawing. Put the initials of the Zontian 
who spoke to the visitor on the back of the drawing slip with some memory-joggers (Lady with red hair, 
Woman who has 5 kids…etc.)  
 
1) Have you ever heard of Zonta?  Yes ___No___ 
 It’s a group of volunteers who help women & girls here & around the world. 
 
2) Do you ever feel like you are too busy to give back or volunteer?  Yes___No___ 

We hear that all the time. 
Our members donate their time, talent and treasure. 
2 hours & $10/Month   
 

3) We are planning a small gathering next week to introduce busy people with  a heart for 
women’s issues, to Zonta.  It will be a fun event, would you like to be invited?   
Yes ___No___       
When they say yes, give details (or invitation flyer) Please come & bring a guest or two!  What is the 
best way /time to reach you? (Make a note of name and contact info – phone & email.)  
 
4) WHO DO YOU KNOW WHO MIGHT APPRECIATE HEARING MORE ABOUT ZONTA?  (Note 
name/phone number or email address - invite the person to bring a guest to info gathering) 
 
Smile! Wear comfy shoes; no chairs behind booth; plan for easy carry & set up. 
Good luck!  

https://www.aauw.org/resource/video-resources/
http://aauw.source4.com/b2c/Category.asp?Category=1824
http://www.zonta.org/


Membership Growth 
 
Three kinds 

__Personal Sponsoring 
__Each One Reach One (encouraging everyone in your organization to bring a 
friend along) 
__Group Sponsoring 
 

JOY - Participation should bring joy to members 
 
TELL - What is Zonta & What makes it great? 

New member retention 
Communication, internal and external 
People 

 
Start them as soon as they say YES and engagement in club activity starts the minute they join. Do you 
have a welcome letter? A “menu” of club committees with descriptions? 
 
Encourage “Two for the Price of one” or the Buddy system. It’s fun to join with a friend. Ask, “Who do 
you know who might also like to hear about Zonta?” 
 
What’s In Your Wallet Game: 

If I asked you to show me a picture of your spouse, your kids, your dog, could you? 
If I asked you to show me a picture or anything about Zonta, could you? 

 
Possible events: 

Membership Bingo 
A Wine & Cheese 
Pedicure Party 

  



Life Hacks for Easy Communications, by Zonta International Headquarters 
 
Communication hacks for success        

• Set a Content Calendar for the biennium with dates and due dates. 
o Global events 
o Zonta events 
o Community events 
o Club events 

• Assign duties with a backup. This is very important for social media accounts. 
• Create templates for design and an outline for your content. 

o Make it easy on yourself by using free templates. 
o What are the top three things people need to know? 
o Something to watch, read, reply, share 
o Share something interesting, even if it’s from another account. 

• Find your influencers, early adapters and “squeaky wheels.” 
o How can they help share your message? 
o What is working for them? 
o What do they want more of? 

• Check your audience and meet them where they are. 
o Do you have young professionals? Ask them if they read their emails or if they'd 

rather get a text message.  
o Could this meeting really have been an email? Why bore your members about 

business when you can send them the notes they need to know.  

  
Social media management 
While Twitter, Facebook and Instagram (through Facebook) allow you to schedule posts ahead 
of time, there are a variety of platforms that allow you to schedule, publish and monitor all of 
your social media activities in one place. Options that have free plans include: 

• Buffer  
• Hootsuite 
• Later 
• Mailchimp 
• Planable 
• Tailwind 

Instagram 
If your clubs and districts are not already on Instagram, we recommend starting an account. Be 
sure to follow Zonta International (@zontaintl) and Firsts for Women (@firstsforwomen) for 
inspiration. 

• Find the most relevant hashtags to use. 
1. Select the magnifying glass icon to visit the Explore tab. 
2. Type in a keyword and tap the Tags column. 
3. Choose a hashtag from the list. 
4. This will take you to a page of posts bearing that hashtag. 
5. Above the “Top” and “Recent” portions of the page, there appears a small bar 

labeled “Related.” Next to this, Instagram will display a list of relevant hashtags 
that you can swipe through for inspiration (and further research). 



• Follow your favorite hashtags. 
1. Select the magnifying glass icon to visit the Explore tab 
2. Type in the hashtag you want to follow 
3. On the hashtag page click the Follow button 

• Stories 
1. Stories allows you to post as much content as you want without cluttering your 

main news feed. Get creative and have fun! 
2. The Stories feature can be found on the top left of your Instagram feed and it is 

highlighted when a new story is posted. 
3. Once you are comfortable with Stories, you can dive into features such as 

polling, Q&As, quizzes and donations. 
 Polling: Ask your followers a question and gain insight. 
 Q & As: These are a great way to engage with your followers and can 

spark a conversation. 
 Quizzes: If you want to gather information about an upcoming event or 

want to test your members’ knowledge, quizzes are a good way to engage 
your followers or gain some insight.  

 Donations: The Donation button allows you to select a nonprofit 
(including Zonta Foundation for Women) to support and have your 
followers donate to that cause. 

4. Use stickers, gifs (we have some Zonta Says NO gifs), music and more to create 
fun, interactive stories. 

5. Stories disappear after 24 hours unless you save them in the Highlights section, 
which appears at the top of your profile. 
 Tap the “+” button to make a new Instagram Story Highlight. 
 You will be taken to your Instagram Archive, where you can see all of your 

past stories. 
 Choose which Stories you want in this Highlight by tapping the circle in the 

bottom-right corner. 
 Tap “Next” and choose a name for your Highlight. 
 Pick out your custom Instagram Highlights cover and click “Add.” 

Creating graphics and images 
Canva 
Canva is a browser-based design tool that makes it easy to create eye-catching images and 
videos. There is also a mobile app. There are three different packages including a free plan, 
which has more than 250,000 free templates, hundreds of thousands of free photos and 
graphics, 5GB of cloud storage, and more. 

• Go to www.canva.com and set up an account if it is your first time. 
• Click the “Create a design” button in the top right corner. You can create a custom size 

or choose from a range of pre-selected sizes such as “Facebook Post,” “Instagram 
Story” and “Twitter Post.” 

• On the left side, there will be templates you can use for your design. You can also build 
from scratch by choosing a background and adding your own photos and text. 

• Quick design tips: 
o Use a template. 

http://www.canva.com/


o Create your own “brand” and stick to that as much as possible by using the same 
colors, fonts and design aesthetic. 

o Use limited fonts. Canva has plenty of fonts to choose from, but do not use too 
many at once because it creates confusion. 

o Your color scheme should include no more than three primary colors and a few 
secondary colors. To stay on brand, choose from our Corporate Brand Colors 
and/or Secondary Color Palette. 

o Keep it simple! 
• To make a video, you can animate graphics or choose stock video (available under 

“Videos” in the slider menu on the left). You can also add music (available under “Audio” 
in the slider menu). 

• When you are done with your design, click the “Share” button at the top right corner. 
You can either click “Download,” “Share on social,” “Print your design” or “More” for 
additional options. 

• For courses such as “Canva for Beginners,” “Graphic Design Basics” and “Social media 
mastery,” visit www.canva.com/designschool/courses.  

 
PowerPoint 
If you have PowerPoint and are familiar with the program, you can use it to create graphics. 
You can: 

• Create a New Presentation and either use a template (which you can find by searching) 
or select “Blank Presentation” and then change the size by going to the Design tab and 
choosing “Slide Size.” Select “Custom Size Slide” and enter the measurements. 

• Access free background graphics and textures. Add your images using “Insert > Photo” 
from the menu and adjust it to fill your slide using the corner handles. Then click on the 
crop tool to cut it down to your slide’s size. Click outside the picture to complete the 
crop. 

• Use any font on your computer. 
• Insert free clip art. 
• Save your images at a resolution you specify: Go to “File > Save as Pictures.” Choose 

to save a JPG or PNG (higher quality but larger file size).  
• Make multiple, similar graphics from a template. 

If you are using PowerPoint to create a presentation, you may access our Zonta International 
template on the PR Tools & Logos page.   
 
 

http://www.canva.com/designschool/courses
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100+ Ideas to Recruit & Maintain Members

Please use this document in conjunction with the Zonta International Marian de Forest Membership Manual. 
Consider selecting a handful of recruitment tactics that you, your club or committee can employ with your personal touch.  
The sections for 'virtual', 'young professionals', and 'convert from prospect to member' are intended to identify actions that may be best used for 
those purposes. Young professionals actions were compiled from current young professionals. Tactics with more Xs are considered more powerful. 
Good luck and happy recruiting!

V YP C
Member Actions

1 Bring a guest to a meeting or event - friends, co-workers and family including spouses, siblings, parents, and (grown-up) children are all potential members XXX
2 When inviting someone to a club event explain incentives and benefits of membership X XX
3 Discuss Zonta with other service club members such as Soroptimist, Rotary and Lions. Members often join more than one organization.
4 When asked about professional leadership skills and career success, tell about your club life as well X XX
5 List Zonta membership in your professional bios XXX
6 Network with coworkers, friends, and family to identify those individuals that are like-minded XX
7 Sign up to speak about Zonta with other groups, share our mission, service and advocacy activities, bring brochures X X
8 Informally share your club experience with others X X
9 When you travel, attend Zonta club meetings or arrange to meet other Zontians and include your travel mates X

10 Wear a Zonta pin to create awareness and start a dialogue
11 Volunteer at local events wearing your club logo gear (shirt, hat, name-tag) X

Club or District Membership Committee Actions
12 Have a clear membership goal & plan, including recruitment - membership is a year-round priority that needs to be planned
13 Maintain a membership recruitment budget: printed material, event costs, etc.
14 Set SMART goals: Smart, Measurable, Achievable, Realistic, and Timely
15 Where possible appoint a campaign manager for the 'Add Your Voice to Zonta' campaign (subcommittee of membership)
16 Assign every member to a recruitment team—each team brings in a new member every six months X
17 Ask every member to submit prospects to the membership chairman X
18 Highlight members or teams that have sponsored a new member in the past year
19 Identify  “recruitment ambassadors” and ask them to share their tips at club meetings X
20 Ask club members for recruitment ideas and gain involvement - individuals may have a social network you did not think of X X
21 Create an invitation template club members can email and/or share on social media X XX
22 Personally follow up prospects from meetings, events, and social media. Thank them for attending and ask if they are considering membership X X
23 Repeatedly invite prospective members, one follow-up is often insufficient, it may take months to get action X X
24 Arrange a meeting between the current club membership chairman and the prospective/new members X X
25 Send newsletter to guests for the full fiscal year to keep Zonta in front of them on a monthly basis until they join X X
26 At club meetings, display a thermometer showing progress towards membership numbers and club goals X
27 The membership committee should lead by example - share details on how many members have been recruited X
28 Give examples and practice members' “elevator speech”. It should convey why they belong and the primary benefit of membership in their view. X
29 Pass out M & M candy to remind members that “Membership Matters” and that we need “More Members”
30 Coach members on making guests welcome - remind members to explain club jargon XX
31 Designate a welcoming committee to greet guests on arrival X
32 Offer guests a packet including service and advocacy projects, details on becoming a member, contact information and upcoming events X X
33 Give testimonials about your club while guests are at the meeting X X X
34 Monitor how new members learn about Zonta, reallocate resources to successful tactics
35 Conduct regular satisfaction surveys identifying 1) what members like and use this in recruitment material and 2) things members want to change, follow up with the board for action
36 Test a more flexible attendance policy to appeal to today's busy lifestyle
37 Consider the local economy: are events and dues affordable XXX
38 Identify member benefits making them as enticing as possible - consider a member “benefit of the month” X
39 Create more fun, members say they join for the mission but stay for the fellowship XXX
40 Plan activities to show interest in member's lives: ask one question of all members, ask members to share a personal story, share at meetings or in newsletters X
41 Post member stories and testimonials on your website or social media XXX
42 Make direct contact with women’s business associations. Together you may have more impact in the community and some members may belong to more than one organization. X
43 Network with other community clubs to raise awareness and attract prospects X
44 Honor outstanding community members with awards and / or yellow roses and tell them about Zonta X
45 Reach out to past members, contacts from past events, social media, etc. and ask their thoughts on membership X
46 Contact past members communicating what has changed in Zonta, identify if there are other barriers to rejoining X
47 Use Zonta promotional material: brochures, videos and banners
48 Create a club specific brochure including the mission, vision, activities and contact information. Promote via QR Code so young professionals can view a digital brochure on their phones X
49 Use printed material: bookmarks, pamphlets, flyers, and posters in public areas
50 Regularly check the Zonta web site for ideas
51 Make sure the club contact information is up to date on Zonta.org to receive referrals X
52 Connect with local universities and colleges, professors as well as degree candidates are often passionate about the Zonta mission X XX
53 Make personal contact with local businesses and ask corporations and employers to sponsor or subsidize membership X
54 Participate in the local 'chamber of commerce', often members are looking for other clubs that share their interests, or, they will be a great network in connecting you with prospects X
55 Meet with local government officials, identify the club mission and share informational materials
56 Connect with new residents. Often real estate companies will provide welcome baskets, ask to include your club information
57 Promote club activities in local media such as neighborhood and special interest newsletters
58 Identify community calendars that may list your club meetings and activities
59 Identify groups such as the 'chamber of commerce' that publish local directories, have Zonta included
60 Ask club members to put club ads on their commercial trucks & buildings
61 Large clubs may consider chartering a second club with a different meeting time, to accommodate people with different schedules
62 If a prospect can’t attend your meeting due to time or location, suggest e-club or individual membership X X
63 Hold recruiting events with two or more Zonta clubs X
64 Add diversity not represented in your club
65 Ask the area director, lt. governor or another district rep. to attend a club or board meeting to talk about membership X
66 Simplify joining activities and the club with online registration and payment X X
67 Test a trial period for new members X
68 Give away something free and useful to new members, such as a flash drive with Zonta information X
69 Induct new members with pizazz & invite spouse/partner, they may be a prospect
70 Develop a welcome note from the president for all guests
71 Recognize new members in newsletters, build recruitment momentum

Club or District Public Relations and Communications Committee
72 Actively maintain the club's social media accounts and ask members to share posts to their feeds X XX
73 Involve members in posting club activities and pictures on social media X X
74 Get permission to tag members in social media pictures, they will show up in their friends' feeds, thus expanding Zonta's network X X
75 Teach members how to share social media content from your club, area, district and international X
76 Establish a club website - even a basic site can help prospects find you or learn more about you X X
77  Add a “Join Us” button to your website - give details on how to come as a guest to a meeting, post testimonials on the benefits of joining X
78 Create a club bumper sticker, pin, shirts, hats or other visual usage of the club logo
79 Post  club meeting times at your meeting place
80 Communicate with your target market using social media ads including Facebook, Google, and LinkedIn. X
81 Registered nonprofits can apply for a Google Ad Grant of up to $10,000 - Google it! X
82 Create a content marketing strategy to align your activities X X
83 Test Search Engine Optimization, so your website is easier to find
84 Connect with readers by sharing stories of your service and advocacy successes  and include a 'donate now' message
85 Advertisement in local media - it is less expensive and more targeted
86 Put a public service announcement on the radio or TV
87 Use billboards at bus stops and road sides
88 Contact local media to cover club projects, send press releases pre and post event

Club Actions
89 Have clear club goals & a strategic plan that includes membership along with service and advocacy X X
90 Hold a club meeting only on membership X
91 Give the membership chairman time at every club meeting X
92 Consider modifying governing documents to appoint the vice president or a board member as membership chair, similar to the lieutenant governor’s role
93 Test club discounts for 1 year, consider a 1x discount for family members
94 Attend meetings of nearby clubs to see what they do differently - road trips are great fellowship opportunities
95 Execute impactful service and advocacy projects that serve a need in the community
96 Create new programs that might entice more diverse members: highlight stories of a diverse range of women X
97 Create a speakers bureau to give talks about club service and / or advocacy to other organizations X
98 Volunteer as a group, get to know other volunteers, they may be a good prospect
99 Give every member a club decal or sticker for their car or pin or jewelry to wear 
100 Ask recipients of club service or donations to speak for Zonta

Event Recruitment Ideas
101 Host community service projects - sharing Zonta service with like-minded individuals can attract prospects X
102 Schedule guest speakers that attract prospects interested in Zonta's mission X X
103 Events such as a charitable run or walk can attract like minded prospects while raising money for an on-mission need X
104 Host a community non-profit event. Local charities will learn about Zonta and one another X
105 Planning a wide variety of events can broaden the appeal and help diversity X
106 Advertise meet and greets at community parks or local businesses, a more casual atmosphere may entice more prospects X
107 Advertise events or high profile meetings in newspapers & cable TV
108 Have a special guest day or make it an ongoing initiative X
109 Host an open house
110 Schedule recruitment events around seasonal themes such as a winter cookie exchange or a spring picnic X
111 Sign up for a table at a local event - have Zonta signage, brochures and identify upcoming activities
112 Hand out invitation cards for a “Free” lunch (breakfast, dinner, beverage) X
113 Offer a 'members-only' rate for events - another benefit of membership visible to attendees
114 Send out a post-event survey, identify if guests would like to learn more about Zonta

Source: 2020-2022 Zonta International Membership Committee with key contributions from Zonta District 11 and Young Professional Members.




